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 1
T h e  C o m p o s i t e  M a t e r i a l s  M o d u l e
The Composite Materials Module is an optional add-on package for COMSOL 
Multiphysics® designed to assist you in modeling structural behavior that includes 
layered shells. The module is an add-on to the Structural Mechanics Module. The 
module is designed for researchers, engineers, teachers, and students who want to 
simulate the behavior of layered structures.

The Composite Materials Module provides the following extensions:

• The Layered Shell physics interface

• The Linear Elastic Material, Layered, the Hyperelastic Material, Layered, and 
the Piezoelectric Material, Layered material models in the Shell interface

• The Linear Elastic Material, Layered material model in the Membrane interface

• Multilayered functionality in the Thin Layer feature in the Solid Mechanics 
interface

• The Thermal Stress, Layered Shell multiphysics interface

• The Piezoelectricity, Layered Shell multiphysics interface (requires also the 
AC/DC or MEMS modules)

• The Piezoresistivity, Layered Shell multiphysics interface (requires also the 
AC/DC or MEMS modules)
 7
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• The Poroelasticity, Layered Shell multiphysics interface (requires also the Porous 
Media Flow module)

• The Layered Shell–Structure Transition, Layered Shell–Structure Cladding, and 
Layered Shell–Shell Connection multiphysics couplings to connect the Layered 
Shell interface with other structural interfaces

• Acoustic–Structure Boundary, Porous–Structure Boundary, Thermoviscous 
Acoustic–Structure Boundary, and Aeroacoustic–Structure Boundary multiphysics 
couplings to connect the Layered Shell interface with acoustics interfaces (requires 
also the Acoustics module). 

• Fluid–Structure Interaction multiphysics coupling to connect the Layered Shell 
interface with fluid interfaces (requires also the CFD module). 

• Lumped–Structure Connection to connect the Layered Shell interface with the 
Lumped Mechanical Systems interface (requires also the Multibody Dynamics 
module).

• The Layered Material node under global materials, in which you specify the layup 
of a stacked material. The Layered Material Stack node under materials. 

The Linear Elastic Material, Layered in the Shell and Membrane 
interfaces is also available with the Structural Mechanics Module. 
However, its usage is then restricted to a single layer material. In that 
context, is mainly intended for modeling using nonlinear material models 
in the Shell interface and multiphysics couplings in the Shell and 
Membrane interfaces.

The Hyperelastic Material, Layered in the Shell interface is available with 
Nonlinear Materials Module. The Piezoelectric Material, Layered in the 
Shell interface is available with AC/DC or MEMS modules.
1 :  T H E  C O M P O S I T E  M A T E R I A L S  M O D U L E



Abou t  t h e  Compo s i t e  Ma t e r i a l s  
Modu l e

In this section:

• What Can the Composite Materials Module Do?

• Where Do I Access the Documentation and Application Libraries?

What Can the Composite Materials Module Do?

Using the Composite Materials Module, a laminated composite shell, also known as 
composite laminate, can be modeled. A composite laminate is an assembly of layers 
with different mechanical properties. The laminate is designed to provide required 
in-plane stiffness, bending stiffness, shear stiffness, coefficient of thermal expansion, 
and so on. Different materials can be used in different layers, producing a hybrid 
laminate. In general, the individual layers are orthotropic or transversely isotropic, 
making the laminate anisotropic.

Multiscale analysis of a composite laminate can be performed using micromechanical 
and macromechanical modeling approaches. A micromechanical analysis considers an 
individual constituents in a material subvolume. The aim is to compute the 
homogenized material properties of a single layer. In contrast, a macromechanical 
analysis considers an entire laminate that consists of many layers. The aim is to compute 
the macroscopic response of a laminate under various loading conditions.

In COMSOL Multiphysics, composite laminates are analyzed either using Layerwise 
3D Elasticity theory through the Layered Shell interface or using First Order Shear 
Deformation theory (ESL-FSDT) theory through one of the Linear Elastic Material, 

Layered, Hyperelastic Material, Layered, or Piezoelectric Material, Layered material 
models in the Shell interface. Very thin laminates, of essentially zero bending stiffness, 
are analyzed using an equivalent single layer theory using the Linear Elastic Material, 

Layered material model in the Membrane interface.

In composite laminates, different types of failures may appear. Thus, it is important to 
perform failure analyses of composite laminates. Both laminate theories allow 
computation of failure indices and safety factors based on various general, as well as 
fiber composite specific, failure criteria. Buckling of a composite laminate is a common 
phenomenon and important to consider in design. In addition, a composite laminate 
A B O U T  T H E  C O M P O S I T E  M A T E R I A L S  M O D U L E  |  9
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consists of many layers glued/laminated together. Under different loading conditions, 
especially impact loading, the bond between two layers may break in a specific region. 
The modeling of delamination initiation and damage propagation is important to 
accurately predict the response of a damaged composite laminate.

Conventionally, a composite laminate is designed based on structural requirements. 
However, for an application where electrical or thermal effects are significant, it is may 
also be necessary to design the laminate based on combined structural, thermal, and 
electrical requirements. A tool is required that can solve for other physical phenomena, 
especially electrical and thermal, in addition to structural mechanics. This multiphysics 
modeling is possible using the Composite Materials Module together with the Heat 
Transfer Module and the AC/DC Module.

Composite laminates are defined on boundaries, with layered materials attached to 
them. They are in general in-plane anisotropic, and heterogeneous in the 
through-thickness direction. It is important to be able to evaluate results in each layer, 
as well as in the through-thickness direction, and not only on the reference surface. 
There are various predefined tools which aid in the visualization of results for a 
composite laminate.

Where Do I Access the Documentation and Application Libraries?

A number of online resources have more information about COMSOL, including 
licensing and technical information. The electronic documentation, topic-based (or 

In the COMSOL Multiphysics Reference Manual:

• Studies and Solvers

• The Physics Interfaces

• For a list of physics interfaces included with a COMSOL Multiphysics 
license, see Physics Interface Guide.
 1 :  T H E  C O M P O S I T E  M A T E R I A L S  M O D U L E



context-based) help, and the Application Libraries are all accessed through the 
COMSOL Desktop.

T H E  D O C U M E N T A T I O N  A N D  O N L I N E  H E L P

The COMSOL Multiphysics Reference Manual describes the core physics interfaces 
and functionality included with the COMSOL Multiphysics license. This book also has 
instructions on how to use COMSOL Multiphysics and how to access the electronic 
Documentation and Help content.

Opening Topic-Based Help
The Help window is useful as it is connected to the features in the COMSOL Desktop. 
To learn more about a node in the Model Builder, or a window on the Desktop, click 
to highlight a node or window, then press F1 to open the Help window, which then 
displays information about that feature (or click a node in the Model Builder followed 
by the Help button ( ). This is called topic-based (or context) help.

If you are reading the documentation as a PDF file on your computer, 
the blue links do not work to open an application or content 
referenced in a different guide. However, if you are using the Help 
system in COMSOL Multiphysics, these links work to open other 
modules, application examples, and documentation sets.

To open the Help window:

• In the Model Builder, Application Builder, or Physics Builder, click a node 
or window and then press F1.

• On any toolbar (for example, Home, Definitions, or Geometry), hover the 
mouse over a button (for example, Add Physics or Build All) and then 
press F1.

• From the File menu, click Help ( ).

• In the upper-right corner of the COMSOL Desktop, click the Help ( ) 
button.
A B O U T  T H E  C O M P O S I T E  M A T E R I A L S  M O D U L E  |  11
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Opening the Documentation Window

T H E  A P P L I C A T I O N  L I B R A R I E S  W I N D O W

Each model or application includes documentation with the theoretical background 
and step-by-step instructions to create a model or application. The models and 
applications are available in COMSOL Multiphysics as MPH files that you can open 
for further investigation. You can use the step-by-step instructions and the actual 
models as templates for your own modeling. In most models, SI units are used to 
describe the relevant properties, parameters, and dimensions, but other unit systems 
are available.

Once the Application Libraries window is opened, you can search by name or browse 
under a module folder name. Click to view a summary of the model or application and 
its properties, including options to open it or its associated PDF document.

Opening the Application Libraries Window
To open the Application Libraries window ( ):

To open the Documentation window:

• Press Ctrl+F1.

• From the File menu, select Help > Documentation ( ).

The Application Libraries Window in the COMSOL Multiphysics 
Reference Manual.

From the File menu, select Application Libraries.

To include the latest versions of model examples, from the File > Help 
menu select ( ) Update COMSOL Application Libraries.

From the File or Windows menu, select Application Libraries.

To include the latest versions of model examples, from the Help menu 
select ( ) Update COMSOL Application Libraries.
 1 :  T H E  C O M P O S I T E  M A T E R I A L S  M O D U L E



C O N T A C T I N G  C O M S O L  B Y  E M A I L

For general product information, contact COMSOL at info@comsol.com.

C O M S O L  A C C E S S  A N D  T E C H N I C A L  S U P P O R T

To receive technical support from COMSOL for the COMSOL products, please 
contact your local COMSOL representative or send your questions to 
support@comsol.com. An automatic notification and a case number will be sent to you 
by email. You can also access technical support, software updates, license information, 
and other resources by registering for a COMSOL Access account.

C O M S O L  O N L I N E  R E S O U R C E S

COMSOL website www.comsol.com

Contact COMSOL www.comsol.com/contact

COMSOL Access www.comsol.com/access

Support Center www.comsol.com/support

Product Download www.comsol.com/product-download

Product Updates www.comsol.com/product-update

COMSOL Blog www.comsol.com/blogs

Discussion Forum www.comsol.com/forum

Events www.comsol.com/events

COMSOL Application Gallery www.comsol.com/models

COMSOL Video Gallery www.comsol.com/videos

Learning Center www.comsol.com/support/learning-center

Support Knowledge Base www.comsol.com/support/knowledgebase
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 2
C o m p o s i t e  M a t e r i a l s  M o d e l i n g
This chapter introduces you to the modeling of composite materials.

In this chapter:

• About Composite Materials

• About Laminated Composite Shells

• Micromechanics Modeling

• Macromechanics Modeling

• Laminated Shell Theories

• Layered Membrane

• Layered Materials

• Layer and Interface Selections

• Failure Modeling

• Structural Couplings

• Multiphysics Modeling

• Results Evaluation
 15
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Abou t  Compo s i t e  Ma t e r i a l s

A composite material is a heterogeneous material formed from two or more 
constituents, assembled to achieve enhanced structural performance. Owing to the 
improved strength and reduced weight, when compared to conventional materials, the 
range of applications of composite materials spans across diverse fields. This 
necessitates a thorough understanding of the behavior of these materials.

Research is underway to find ways to embed functionality like sensing, actuation, 
computation, and communication into composite materials. This is known as smart 
composite materials.

Some examples of engineered composite materials for various applications include:

• Fiber reinforced polymers

• Reinforced concrete beams

• Composite wood or plywood

• Ceramic matrix composites

• Sandwich structures

• Metal matrix composites

Among different types of engineered composite materials, the use of fiber reinforced 
polymer (FRP) is growing rapidly. Applications include aircraft components, spacecraft 
components, wind turbine blades, automobiles, buildings, boat hulls, bicycles, and 
safety equipment.

This section includes:

• Classification of Composites

• Fiber-Reinforced Polymer (FRP) Composites

• Benefits of Composites

• Challenges of Composites

Classification of Composites

There are several ways to classify composite materials, and one way is to categorize 
them based on their constituents: the type of matrix material, and the type of 
reinforcement.
 2 :  C O M P O S I T E  M A T E R I A L S  M O D E L I N G



Based on the type of matrix material, composite materials can be categorized as:

• Polymer matrix composites (PMC)

• Metal matrix composites (MMC)

• Ceramic matrix composites (CMC)

• Cement matrix composites (CeMC)

Based on the reinforcement shape, composite materials can also be categorized as:

• Continuous fibers

• Random short fibers

• Flakes

• Whiskers

• Particulate

A commonly used type of fiber-reinforced polymer (FRP) is polymer matrix 
composites (PMC), in which continuous fibers are used as reinforcement.

Fiber-Reinforced Polymer (FRP) Composites

A fiber-reinforced polymer (FRP) typically consists of a fibrous part, which acts as the 
main load carrying element, and a surrounding matrix/resin to support the fiber, and 
transfer the load. The fibers are arranged in a specified orientation in each layer 
(equivalently lamina or ply) of the material. A number of layers are stacked to form a 
laminated composite material which can be used in structural components.

The use of fiber composites in the manufacturing industry is increasing, as fiber 
composites are lighter and more corrosion resistant compared to traditional metallic 
engineering materials. Moreover, properties like strength, stiffness, and toughness can 
often be tailored to a specific application.

The fibers used for industrial applications are in general made of carbon, glass, aramid, 
or basalt. Based on the type of fiber material, the two most popular FRPs in industry 
are:

• Carbon fiber reinforced polymers (CFRP)

• Glass fiber reinforced polymers (GFRP), also known as fiberglass
A B O U T  C O M P O S I T E  M A T E R I A L S  |  17
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Benefits of Composites

Composite materials offer many benefits over conventional metallic materials. Some 
possible benefits are:

• High strength to weight ratio

• High resistance to fatigue and corrosion degradation

• Improved friction and wear properties

• Low thermal conductivity and low coefficient of thermal expansion

• Possibility to tailor material properties to meet specific design requirements

Challenges of Composites

Considering that composite materials are manufactured materials, there are challenges 
involved when selecting a composite material for an application:

• High cost of raw materials and fabrication

• Difficulty in reuse and disposal

• Difficulty in joining different components

• Different types of failure modes

• Anisotropic materials — difficult to analyze
 2 :  C O M P O S I T E  M A T E R I A L S  M O D E L I N G



Abou t  L am i n a t e d  Compo s i t e  S h e l l s

A laminated composite shell, also known as composite laminate, is an assembly of layers 
(laminae, plies) of composite materials. It is assembled to meet specific design 
requirements on, for example, in-plane stiffness, bending stiffness, shear stiffness, and 
coefficient of thermal expansion. Different materials can be used in different layers, 
resulting in a hybrid laminate. In general, the individual layers are orthotropic or 
transversely isotropic, making the composite laminate anisotropic.

This section includes:

• Reinforcement Arrangement

• Stacking Sequence

• Types of Laminates

• Analysis on Different Scales

Reinforcement Arrangement

Depending on the manner in which fibers are arranged in a matrix material, composite 
plies can be categorized as:

• Unidirectional composite

• Bidirectional composite

• Woven fabric composite

• Particulate composite

Woven fabric composites are produced by the interlacing of warp (0°) fibers and weft 
(90°) fibers, in different weave styles. A woven fabric can be in biaxial, triaxial, or 
multiaxial configurations, and can have different types of weaving, namely planar 
weaving or 3D weaving.

Particulate composites are made by introducing particles, flakes, or whiskers into an 
otherwise isotropic matrix.
A B O U T  L A M I N A T E D  C O M P O S I T E  S H E L L S  |  19
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Stacking Sequence

A composite laminate is defined as the stacking of two or more composite plies with 
the same or different fiber orientations. The plies (layers) can be made of the same or 
different materials, with individual thicknesses.

The stacking sequence, shown in Figure 2-1, is defined by the fiber orientation of each 
ply with respect to the first axis of the laminate coordinate system. The stacking 
sequence is interpreted from bottom to top, and the orientation angles are in general 
specified in degrees.

Figure 2-1: Example of a stacking sequence [0/45/90/-45/0] used in a composite 
laminate.

The stacking sequence is expressed in a concise form that is particularly suitable for 
laminates with a large number of plies (layers), using the fact that most laminates are 
either symmetric or contain many plies of the same orientation.

0°

-45°

90°

45°

0°
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Some examples of stacking sequences are given in the table below:

Types of Laminates

Based on the stacking sequence, composite laminates can be categorized as:

Angle-ply Laminate
A laminate is called an angle-ply laminate if it has layers of the same thickness and 
material, and are oriented at θ and −θ.

Cross-ply Laminate
A laminate is called a cross-ply laminate if all the layers have the orientation 0° and 90°.

Balanced Laminate
A laminate is called a balanced laminate when it has pairs of layers of the same 
thickness and material, and the angles of the layers have opposite signs. Balanced 
laminates can also have layers at 0° and 90°.

Symmetric Laminate
A laminate is called symmetric when the material, angle, and thickness of the layers are 
the same above and below the midplane.

Antisymmetric Laminate
A laminate is called antisymmetric when the material and thickness of the layers are 
the same above and below the midplane, but the orientation of the layers have opposite 
signs above and below the midplane.

Analysis on Different Scales

The analysis of a composite laminate is comparatively difficult as it spans different 
length scales. At the micro level, individual fibers or particles embedded in a matrix 

TABLE 2-1:  EXAMPLE STACKING SEQUENCES.

STACKING SEQUENCE ORDER OF THE PLIES PLIES

[45/-30/0] 45°, -30°, 0° 3

[45/-30/0]s 45°, -30°, 0°, 0°, -30°, 45°
(s = symmetric)

6

[45/-30/0]3 Three repeated sets of 45°, -30°, 0° 9

[(45)2/-30/(0)3]s 45°, 45°, -30°, 0°, 0°, 0°, 0°, 0°, 0°, -30°, 45°, 45° 12

[45/-30/0]as 45°, -30°, 0, °0°, 30°, -45°
(as = antisymmetric)

6
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material are considered, and at the macro level, the homogenized behavior of the 
composite laminate is considered.

M I C R O M E C H A N I C S  A N A L Y S I S

This analysis considers the modeling of individual layers using either repeating unit cell 
(RUC) or representative volume element (RVE) of fibers or particles in a matrix. The 
micromechanics analysis is used to compute the homogenized material properties of a 
single layer.

M A C R O M E C H A N I C S  A N A L Y S I S

This analysis considers the modeling of a laminate having many layers. The 
homogenized material properties of a single layer, computed in the micromechanics 
analysis, is the input to this analysis. The aim is to compute the global response of a 
laminate under various loading conditions.

M U L T I S C A L E  A N A L Y S I S

In a multiscale analysis, you typically compute the global response using a 
macromechanics analysis, and then use the global stress and strain field in a set of 
points to as boundary conditions for a microscale model, in order to determine local 
stresses and strains.
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M i c r ome chan i c s  Mode l i n g

To analyze components made from laminated composites, it is necessary to quantify 
the material properties of an individual lamina (layer, ply). The task of computing 
homogenized material properties using either repeating unit cell (RUC) or 
representative volume element (RVE) is known as micromechanics analysis. The 
homogenized material properties can be computed when the material properties and 
distribution for the fibers and matrix are known.

Constituents of a Lamina

A lamina, in general, consists of fibers in a matrix. The homogenized properties of a 
lamina depend on the material properties of the fibers and the matrix, and on their 
distribution. The fibers are in general orthotropic, whereas the filler material is 
isotropic.

Figure 2-2: Example of a unit cell of a lamina having fiber and matrix materials.

A repeating unit cell (RUC) or representative volume element (RVE), is the smallest 
volume element which can be repeated to describe the full lamina. An example of a unit 
cell is shown in Figure 2-2, where it is assumed that the fibers are located on a regular 
square lattice. With this RUC, the volume fraction of fibers is sufficient to describe the 

Fiber

Matrix
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fiber content in the lamina. The length of the RUC in the fiber direction is immaterial, 
while the size in the two transverse directions is given by the spacing between fibers.

Parts for Micromechanical Analysis

In the Geometry toolbar navigate to Parts > Part Libraries. In the Part Libraries, under 
COMSOL Multiphysics > Unit Cells and RVEs, several parameterized geometries for 
common micromechanical structures are available. They form a good basis for 
computing homogenized material properties.

Figure 2-3: Some examples of unit cell geometries in the Part Libraries.

Homogenization and Cell Periodicity

In order to perform a micromechanics analysis of a composite lamina and compute its 
homogenized orthotropic material properties, the Cell Periodicity node in the Solid 
Mechanics interface is used.

In order to extract the homogenized material properties, the Cell Periodicity node 
performs the following sequence of operations:

• Applies periodic boundary condition to three pairs of faces of the RUC or RVE.

• Creates a stationary study with six different unit load cases.
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• Solves load cases and obtains the components of homogenized elasticity matrix of a 
lamina from the computed stress-strain relations.

• Creates a new homogeneous material node under Global Definitions- > Materials and 
assigns the computed homogenized elasticity matrix to it.

This new homogeneous material can be used as an input to the macromechanics 
analysis.

In the Structural Mechanics Module User’s Guide:

• Effective Properties of Periodic Structures

• Cell Periodicity

• Cell Periodicity
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Mac r ome chan i c s  Mode l i n g

Modeling a composite laminate and computing its response under loading is known as 
macromechanics analysis. The homogenized material properties of a lamina computed 
using a micromechanics analysis can be used as input to the macromechanics analysis.

In order to model a composite laminate, the following properties need to be specified:

• Number of layers

• Homogenized material properties of each layer

• Orientation of the principal material directions

• Thickness of each layer

• Stacking sequence

Figure 2-4: A 3D representation of a composite laminate showing the total laminate 
thickness and the laminate coordinate system.
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Figure 2-5: Through-thickness (2D) representation of a composite laminate with n layers. 
The thickness and fiber orientation of each layer are indicated. The position of the reference 
surface with respect to the laminate is also shown.

In order to attach the layer definition to geometric surfaces, the following properties 
need to be defined:

• Laminate coordinate system: These are the global directions for a composite 
laminate about which the stacking sequence is interpreted as shown in Figure 2-4.

• Reference surface position: This is the position of the reference surface or geometric 
surface with respect to the midplane of the laminate as shown in Figure 2-5.

Once these definitions are specified, a regular finite element modeling approach can be 
used. It involves setting up the physics (loads, boundary conditions), creating a finite 
element mesh, performing various types of analysis, including static, dynamic, failure, 
buckling, and multiphysics analysis.
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L am i n a t e d  S h e l l  T h e o r i e s

The analysis of laminated composite shells is commonly based on one of three different 
theories:

1 Equivalent single layer (ESL) theory

a Classical laminated plate theory (CLPT)

b First order shear deformation laminated plate theory (FSDT)

c Higher order shear deformation laminated plate theory

2 Three dimensional elasticity theory

a Traditional 3D elasticity theory

b Layerwise 3D elasticity theory

3 Multiple model methods

In COMSOL Multiphysics, composite laminates are analyzed either using layerwise 
3D elasticity theory through the Layered Shell interface or using first order shear 
deformation theory (ESL-FSDT) theory through the Linear Elastic Material, Layered, 
Hyperelastic Material, Layered, or Piezoelectric Material, Layered material models in the 
Shell interface.

This section includes:

• Equivalent Single Layer (ESL) Theory

• Layerwise (LW) Theory

• Selection of an Appropriate Laminate Theory

Equivalent Single Layer (ESL) Theory

Composite laminates are formed by stacking layers of different materials and/or 
different fiber orientations. In general, their planar dimensions are two orders of 
magnitude larger than their thickness. Often laminated structures are used in 
applications requiring high membrane and bending strengths. Therefore, in many 
cases, composite laminates can be modeled using a shell element based on an 
equivalent single layer theory.

This is a classical way of modeling composite laminates. This theory treats a 
heterogeneous laminated composite as a statically equivalent single layer. It reduces a 
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3D continuum problem to an equivalent 2D problem, thus reducing the size and 
computational time of the problem.

In addition to simplicity and low computational cost, this theory provides sufficiently 
accurate description of the global response for a thin to moderately thick laminates 
such as gross deflections, critical buckling loads, and eigenfrequencies with 
corresponding mode shapes.

C L A S S I F I C A T I O N

The ESL theories can be classified into various groups based on the description of the 
transverse shear stresses.

Classical Laminate Plate Theory (CLPT)
The classical laminate plate theory is an extension of Kirchhoff or classical plate theory 
used for single layer thin shells. In this theory, transverse shear stresses are neglected 
and the deformation is entirely due to the bending and in-plane stretching.

First Order Shear Deformation Theory (FSDT)
The first order shear deformation theory is similar to the Mindlin–Reissner shell theory 
used for single layer thick shells. This theory extends the kinematics of CLPT by 
including the gross transverse shear deformation. The transverse shear strain is 
assumed to be constant with respect to the thickness coordinate. As the transverse 
shear strain has a constant value, this theory requires a shear correction factor.

Higher Order Shear Deformation Theory
This theory is the extension of FSDT, and here the displacement field is approximated 
in such a way that the transverse shear strain varies quadratically with respect to the 
thickness coordinate. It makes the transverse shear stresses zero at the top and bottom 
surfaces of the laminate and thus eliminates the need of a shear correction factor.

F I R S T  O R D E R  S H E A R  D E F O R M A T I O N  T H E O R Y  ( F S D T )

In COMSOL Multiphysics, the first order shear deformation (ESL-FSDT) theory is 
one of the options for analyzing composite laminates. This theory is implemented in 
the Linear Elastic Material, Layered, Hyperelastic Material, Layered, and Piezoelectric 

Material, Layered material models in the Shell interface. It has an MITC (mixed 
interpolation of tensorial components) formulation. As this theory accounts for the 
transverse shear deformation, it can be used for thick shells.

K E Y  F E A T U R E S

• Degrees of freedom (3 displacements, 3 rotations) are defined only at the midplane 
or reference plane of the composite laminate.
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• Suitable for modeling thin to moderately thick laminates.

• Suitable for finding the global response of the laminate such as gross deflections, 
eigenfrequencies, and critical buckling load.

• Computationally inexpensive, and thus suitable for analysis of laminates having large 
numbers of layers.

• Requires a shear correction factor for thicker laminates, where transverse shear 
stresses are not negligible

Layerwise (LW) Theory

A layerwise (LW) theory for modeling composite laminates is very similar to a 
traditional 3D elasticity theory, where the degrees of freedom are the displacements 
defined in the product geometry created by the reference surface, and an extra 
dimension in the thickness direction.

There are two approaches depending on the way degrees of freedom are defined:

• Partial displacement field approach

• Full displacement field approach

In the partial displacement field approach, the laminate thickness remains constant, 
whereas the full displacement field approach allows a change in thickness of the 
laminate. In COMSOL Multiphysics, a full displacement field based layerwise theory 
is implemented in the Layered Shell interface.

The layerwise theory is more accurate than the equivalent single layer theory, but it 
comes at the cost of more degrees of freedom. It is significantly more expensive in 
terms of computer resources.

From accuracy point of view, the layerwise theory is as accurate as traditional 3D 
elasticity theory, but it has several benefits:

• No need to build a 3D geometry with many thin layers.

• Easy to handle layerwise and interfacial data.

In the Structural Mechanics Module User’s Guide: Theory for FSDT 
Laminated Shell
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• In-plane finite element meshing is independent of the out-of-plane (thickness 
direction) meshing.

• A separate, either lower or higher, shape function order can be chosen in the 
thickness direction in order to avoid shear locking or to gain accuracy advantages.

K E Y  F E A T U R E S

• Degrees of freedom (3 displacements) are defined in the product geometry created 
by the reference surface, with an extra dimension in the thickness direction.

• Predicts correct through-thickness or transverse shear stress variation, thus making 
it suitable for modeling thick shells.

• Predicts correct interlaminar stresses, and has degrees of freedom in the thickness 
direction making it suitable for delamination and detailed damage analysis.

• Supports nonlinear material models for advanced composite modeling.

• Supports different material models in different layers of a laminate. It is for example 
possible to combine linear elastic and hyperelastic materials in a single laminate.

Selection of an Appropriate Laminate Theory

In the above two sections, the key features of both equivalent single layer and layerwise 
theories have been outlined. Based on that, an appropriate laminate theory can be 
chosen for a particular problem. Without going into more details, the laminate aspect 
ratio (the ratio between in-plane size and thickness) gives an important hint about the 
theory that would be more suitable for a particular laminate.

In Figure 2-6, it can be seen that ESL theory is more suitable for moderately thick to 
very thin laminates, whereas layerwise theory is more suitable for moderately thin to 
very thick laminates. The selection of ESL theory for very thick laminates may give rise 
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to incorrect transverse shear stresses whereas the selection of layerwise theory for very 
thin laminates may give rise to shear locking.

Figure 2-6: Selection of an appropriate laminate theory based on the laminate aspect 
ratio.

Layerwise Theory

ESL Theory

Laminate Aspect Ratio

Very ThinVery Thick
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L a y e r e d  Memb r an e

In order to model very thin laminates with low bending stiffness, the Equivalent Single 
Layer theory can be extended to the membrane elements. One of the applications of 
the layered membrane is in the modeling of acoustic devices.

In COMSOL Multiphysics, very thin laminates are analyzed using the equivalent 
single layer theory through the Linear Elastic Material, Layered in the Membrane 
interface. This material model is a membrane version, with zero bending and shear 
energies, of the Linear Elastic Material, Layered material model in the Shell interface, 
which is based on the First Order Shear Deformation theory.
L A Y E R E D  M E M B R A N E  |  33



34 |  C H A P T E R
Th i n  L a y e r s

In the Solid Mechanics interface, there is a possibility to model thin layers on 
boundaries between solid domains, using the Thin Layer feature. It can also be used 
to model a cladding on an exterior boundary. With the Composite Materials Module, 
such thin layers can internally be multilayered. The same type of Layered Materials that 
is used for shells and membranes is applicable also in this case.
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L a y e r e d  Ma t e r i a l s

The technique for defining material data and other properties for a layered shell is 
somewhat different from what is common in most other physics interfaces. In general, 
several different materials are used on the same boundary, so it would not be possible 
to use the assignment in a normal Material node in the component.

Rather, you defined the whole laminate, including materials, layer thickness, 
orientations, and so on, as one unit. The workflow is described in this section.

This section includes:

• Defining a Layered Material

• Connecting a Layered Material to the Physical Geometry

• Defining a Laminate Coordinate System

• Defining a Layer Local System

• Defining a Layered Material Stack

• Defining Variable Thickness Layers

• Ply-Based Modeling Approach

• Saving and Loading Layered Material

• Sweep over Layered Materials

• Visualizing 3D Geometry and Fiber Draping

Defining a Layered Material

Start by adding a Layered Material at the Materials node under Global Definitions. Then, 
take the following steps to define the laminate:

• Add the required number of layers in the Layer Definition section of a Layered 

Material node.

• Define the referenced materials under the Materials node. You can either add a Blank 

Material and fill in the required material properties or choose a material from the 
Material Library.

• Select the appropriate material in each layer.

• Define the rotation angle (in degrees) for each layer. This is the orientation of the 
fiber direction with respect to the principal laminate coordinate system.
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• Define the thickness of each layer.

• By default, two mesh elements in each layer are used which means there are two 
sublayers in each material layer. Optionally, you may want to either increase or 
decrease the number of mesh elements in an individual layer in order to improve the 
accuracy or reduce the computation time.

I N T E R F A C E  M A T E R I A L S

By default, no material is selected on the interface between two layers in the 
through-thickness direction. The material properties at the interface are taken as an 
average of the two adjacent layer properties.

All the layers are assumed in a continuity state. Optionally, in order to model a very 
thin layer of material, for example a glue layer between the two material layers, a 
material can be added in Interface Properties section. If an interface material is defined, 
you can create a discontinuity between two layers and use the interface material 
properties. To do this, add a Delamination or Thin Elastic Layer, Interface node in the 
Layered Shell interface. All interfaces selected in that node should have a material 
assignment, but there is no need to assign a material to interfaces which are not 
affected by such special features.

P R E V I E W  P L O T S

As the physical geometry is only the boundaries, it becomes important to visualize the 
layup, including stacking sequence and thickness values for each layer.

You can do that by creating Layer Cross Section Preview ( ) and Layer Stack Preview 
( ) plots. An example of a layer cross section plot showing a 2D cross section of a 

Note that required material properties for the material in a certain layer 
depends on the Solid Model chosen in the Linear Elastic Material node in 
Layered Shell or Linear Elastic Material, Layered node in Shell interface.

• For the Isotropic model (with Young’s modulus and Poisson’s ratio 
option), scalar values of Young’s modulus and Poisson’s ratio are 
required.

• For the Orthotropic and Transversely Isotropic model, Young’s 
modulus, shear modulus, and Poisson’s ratio along the principal 
material directions is required.

• For the Anisotropic model, the full homogenized elasticity matrix of 
along the principal material directions is required.
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laminate having is shown in Figure 2-7. The thickness of each layer is visible. An 
example of a layer stack preview plot showing the stacking sequence is shown in 
Figure 2-8.

Figure 2-7: Example of a layer cross section preview plot showing a composite laminate 
having 5 layers with different thickness values.

Figure 2-8: Example of a layer stack preview plot showing a composite laminate having 5 
layers with stacking sequence [0/45/90/-45/0].
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Note that in the layer stack preview plot, the distance between any two layers is always 
the same and it does not reflect the actual thickness of the layers.

Since the preview plots are used for a variety of composite laminates having different 
combination of number of layers, thickness values, and stacking sequence, it is possible 
to customize the plot settings in terms of changing the thickness to width ratio or the 
distance between the orientation lines. It is also possible to switch off the orientation 
lines and labels.

You can also create the two preview plots under Results section using Create Layer Cross 

Section Plot and Create Layer Stack Plot buttons respectively. This helps in storing the 
preview plots in the model and also allows them to be available in an application, built 
on top of the model.

Connecting a Layered Material to the Physical Geometry

After creating the layered material definition, the next step is to attach the layer 
definition to the physical geometrical surfaces. The most fundamental way of doing 
that is through a Layered Material Link node, which you add under the Materials node 
within a component.

In that node, you select the boundaries where you want to attach the layer definition. 
The position of the geometric boundaries with respect to laminate definition is also 
defined. You can attach the boundary to the laminate midplane, downside, upside, or 
at a user-defined location as shown in Figure 2-9.

In the COMSOL Multiphysics Reference Manual:

• Layered Material
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Figure 2-9: Position of geometric boundaries with respect to the composite laminate.

It is also possible to use some of the transform options while attaching the layer 
definition to the boundaries. By default, the layer definition is used as it is however it 
is possible to use the following transform options:

• Symmetric

• Antisymmetric

• Repeated

Defining a Laminate Coordinate System

The next step is to define a coordinate system for the composite laminate in which the 
stacking sequence is interpreted. You can either customize the default Boundary System 
or add new boundary systems under the Definitions node within a component. Select 
the coordinate system in the Layered Material Link node.

Midplane (relative offset 0) Up side (relative offset -1)

Down side (relative offset 1) User defined (relative offset -0.5)
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To create a suitable laminate coordinate system using the Boundary System node

• Define an appropriate direction from which the first tangent direction of the 
coordinate system is obtained

• Reverse the normal direction if needed

Some examples of laminate coordinate systems in a cylindrical composite laminate, 
using different Boundary System settings are given below.

Example 1
The first axis of the laminate coordinate system is aligned with the global x direction. 
This can be created by setting the Create first tangent direction from option to Global 

Cartesian (spatial) and the Axis to x.

Figure 2-10: Example of a laminate coordinate system when the first axis is aligned with 
the global x direction.

Example 2
The first axis of the laminate coordinate system is at 45° to the global x direction. This 
can be created by first defining a Cylindrical System having Longitudinal axis as x-axis 
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and then setting the Create first tangent direction from to Cylindrical System and Axis to 
Manual with {0,-1,1} as orientation.

Figure 2-11: Example of a laminate coordinate system when the first axis is at 45° to the 
global x direction.

Example 3
The first axis of the laminate coordinate system is aligned with the global x direction 
but with the normal direction pointing inward. This coordinate system can be created 
in a same way as in the first example. In addition to that, the Reverse Normal direction 
option is selected in the Boundary System node in order to flip the normal vector 
direction.

Figure 2-12: Example of a laminate coordinate system where the first axis is aligned with 
the global x direction and the normal vector is pointing outward and inward respectively.

Note that it is also possible to reverse the normal direction only on some 
selected boundaries by using the Reverse Normal subnode on the Boundary 

System node.
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Defining a Layer Local System

Each layer in the composite laminate has different material orientations defined by the 
rotation angle and the laminate coordinate system. The rotation angle of each layer is 
defined in the Single Layer Material or Layered Material node. The Layer Local System is 
then created by rotating the laminate coordinate system in the reference plane by this 
rotation angle.

Some examples of layer local coordinate systems in a cylindrical composite laminate 
having different stacking sequences, are given below.

Some examples of layer local coordinate systems in a cylindrical composite laminate, 
using different stacking sequences, are given below.

Example 1
The stacking sequence of a composite laminate is [0/30/60/90]. The first axis of the 
laminate coordinate system is aligned with the global x direction. This can be created 
by setting the Create first tangent direction from option to Global Cartesian (spatial), and 
by setting the Axis to x.

In the COMSOL Multiphysics Reference Manual:

• Layered Material Link

• Boundary System
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.

Figure 2-13: Example of a layer local coordinate system in different plies. The first axis of 
the laminate coordinate system is the global x direction.

Example 2
The stacking sequence of a composite laminate is [-15/15/-45/45]. The first axis of the 
laminate coordinate system is at 45° to the global x direction. This can be created by 
defining a Cylindrical System having Longitudinal axis as x-axis. Then set the Create first 

tangent direction from to Cylindrical System and the Axis to Manual with {0,-1,1} as the 
orientation.
L A Y E R E D  M A T E R I A L S  |  43



44 |  C H A P T E R
Figure 2-14: Example of a layer local coordinate system in different plies. The first axis of 
the laminate coordinate system is at 45° with respect to the global x direction.

Example 3
The stacking sequence of a composite laminate is [0/30/60/90]. The first axis of 
laminate coordinate system is aligned with the global x direction but with the normal 
direction pointing inward. This coordinate system can be created in a same way as in 
the first example. In addition to that, the Reverse Normal direction option is selected in 
the Boundary System node in order to flip the normal vector. 
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Figure 2-15: Example of a layer local coordinate system in different plies. The first axis of 
the laminate coordinate system is the global x direction, and the normal vector is pointing 
inward the cylinder.

Defining a Layered Material Stack

It is common that different layered materials are stacked on top of each other to build 
a composite laminate. An example is a laminate having the stacking sequence [A/B/
C/B/A] where A, B, C are three different layered materials or sublaminates.

To simplify such modeling, use the Layered Material Stack node under the Materials 
node within a component. In a Layered Material Stack, you define the position and 
laminate coordinate system similar to what is done in a Layered Material Link. You can 
link multiple layered materials in the stacking order. An example of a layered material 
stack having three different layered materials is shown in Figure 2-16.
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Figure 2-16: Example of a layered material stack having three different (A,B,C) layered 
materials.

Defining Variable Thickness Layers

In some applications, one or more layers in a laminate can have a thickness variation as 
a function of geometry coordinate. These layers are typically core layers in sandwich 
laminates. This can be achieved by using the Scale option in the Layered Material Link 
or Layered Material Stack nodes.

In order to scale the entire laminate, the Layered Material Link node can be used 
however for individual layer scaling as shown in Figure 2-17, the Layered Material Stack 
node more suited.

A

B

C

B

A

Note that it is also possible to add a Layered Material node directly under 
the Layered Material Stack node.

In the COMSOL Multiphysics Reference Manual: Layered Material 
Stack
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Figure 2-17: Example of a layered material having a variable thickness layer in the 
middle shown in black.

Ply-Based Modeling Approach

There are two ways in which a complex composite laminate, with different layups in 
different parts of the structure, can be modeled:

• Using a zone-based modeling approach

• Using a ply-based modeling approach

The zone-based modeling approach is a traditional way of defining a layup in a 
composite laminate. First, all zones in the composite laminate that have different 
layups are identified. Second, the layup in each zone is defined using the Layered 

Material Link or Layered Material Stack node. This approach works fine as long as there 
is a limited number of ply drop-offs, so that the number of zones is limited.

In the case of a complex composite laminate with many ply drop-offs, and thus many 
zones, identifying and then defining the layup for each zone individually becomes a 
cumbersome process. In such a scenario, a ply-based modeling approach can be used. 
Here, only one layup is defined for all the zones using a Layered Material Stack node. 
Each ply then has its own selection, which is a subset of the selection of the Layered 

Material Stack node. This is different compared to the zone- based modeling approach, 
where each ply in the Layered Material Stack has the same selection.
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Figure 2-18: Zones created in the ply-based modeling approach. The layup in each zone can 
also be seen. A ply having sectioning represents the variable thickness ply.

Based on the overall layup information and the selection of each ply, different zones 
are automatically created and shown in the Stack Zone Definition section of the Layered 

Material Stack node. Each zone is treated as a different layered material and can be used 
accordingly in the physics and in postprocessing.

The typical steps involved in defining a complex layup using the ply-based modeling 
approach are:

• Use a Layered Material Stack node and make the selection where you want to define 
a layup.

• Add all the plies to the Layered Material Stack node in the specified stacking sequence 
using its subnodes — Layered Material link, Layered Material, or Single Layer Material.

• Define the boundary selection of each ply where it is physically present. This 
selection should be a subset of the Layered Material Stack node’s selection.

• Based on the specified stacking sequence and the selection of each ply, the entire 
selection is divided into various zones which can be seen in the Stack Zone Definition 
section in the Layered Material Stack node.

• The table in the Stack Zone Definition section lists the Name of the zones, the Stack 

members in each zone, and the geometric Selections of each zone.

• Click on each row in the table to visualize the boundary selection of the zones in 
the Graphics window.
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• Click the Layer Cross Section Preview plot button to visualize all the zones and their 
stacking sequence, as shown in Figure 2-18.

• Click the Layer Stack Preview plot button to visualize the overall stacking sequence, 
and further, click on each row of the table to visualize the stacking sequence in each 
zone.

Saving and Loading Layered Material

After setting up a layered material definition together with the material properties of 
each layer, you may want to save it in order to reuse the data in a different model. This 
can be achieved in two different ways:

• Add the Layered Material to a User-Defined Library by right-clicking and choosing this 
option. This adds the layer definition as well as the material properties of each layer 
to the user-defined library.

• Save the model file with only the layered material setup.

Next time when you want to use the same layered material setup, then either you can 
add it from a User-Defined Library if it is available there, or you can browse to the model 
file in which layered material is stored by following these steps:

• Right click on Materials node under Global Definitions and choose Browse Materials.

• Choose Import Material Library and browse to the model file containing the layered 
material definition.

• Choose a layered material from the newly added material library and add it to the 
Global Materials in the model. Alternatively, you can add it to the User-Defined 

Library.

Sweep over Layered Materials

In many cases, a primary goal while designing a composite laminate is to optimize the 
layered material definition which includes number of layers, arrangement of layers, 
material properties of each layer, thickness of each layer, and stacking sequence.

In order to do this, you can add multiple Layered Material nodes under a Switch node. 
You add the Switch node from Materials under Global Definitions. The Switch node can 

In the COMSOL Multiphysics Reference Manual: Layered Material 
Stack
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be selected in the Layered Material Link node. However, all Layered Material nodes 
under a Switch node must have same number of layers, even though they can have 
different total thickness. To handle a case with several materials having different 
number of layers, you can split the layers in one or more Layered Material by adjusting 
layer thicknesses while keeping total thickness constant, so that total number of layers 
in all Layered Materials are the same.

With these settings, it is possible to add a Material Sweep node to any study in order to 
solve for all layered materials.

Sensitivity Analysis of Layered Materials

It is not possible to directly compute the sensitivity of some result with respect to a 
layer thickness. This is an operation that you would, for example, need for optimization 
studies. There is, however, an indirect way to obtain such a sensitivity, and that is to 
use the Scale property available in a Layered Material Link. A scaling acts on all layers in 
a Layered Material Link node. In order to scale individual layers, you can use a Layered 

Material Stack, and add separate Layered Material Link subnodes pointing to these layers.

Visualizing 3D Geometry and Fiber Draping

In complex structures, sometimes it becomes important to visualize the 3D solid 
geometry which corresponds to a composite laminate modeled using the surface 
geometry. It gives a clear picture of the number of layers as well as laminate thickness 
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in different regions of the structure. In order to visualize this, a result template is 
available in the Layered Shell and Shell interfaces as shown in Figure 2-19.

Figure 2-19: 3D solid geometric representation (scaled in thickness direction) of a 
composite laminate having six layers.

In addition to visualizing the stacking sequence of a laminate, visualization of the fiber 
draping direction on the physical geometry is also useful. A result template as shown 
in Figure 2-20 is available in the Layered Shell and Shell interfaces.

Figure 2-20: First principal material direction showing the fiber draping direction in 
each layer of a composite cylinder.
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L a y e r  and I n t e r f a c e  S e l e c t i o n s

Once a layered material is defined, it is possible to use the layer information while 
setting up the selections in a physics interface and its different features.

The physics features can be of two, fundamentally different, types: Those who act on 
the layers themselves, and those who act on the interfaces between layers. The settings 
for these two types of features are slightly different.

L A Y E R  F E A T U R E S

The physics interface and its layer features have a section named Shell Properties. The 
layer selections made in this section interact with the standard selections of geometrical 
objects (boundary, edges, or points) in order to provide a complete specification of 
where a material property or boundary condition is to be applied.

The default selections in the Shell Properties section differ between different physics 
features. This reflects the fact that some physics features (such as thermal expansion) 
are more likely to be applied to all layers, whereas other features (such as added mass) 
are more likely to be used for a single layer or interface.

The section always contains a checkbox named Use all layers. When selected, you 
cannot control individual layers; the contribution is given to all layers. All information 
is taken from the definitions made in the layered material features (Layered Material 

Link, Layered Material Stack, or Single Layer Material) under Materials in the current 
component. This means that a single physics node can accommodate several different 
stacking sequences. As geometrical selection, you can use any object selected in any of 
the layered material features.

When Use all layers is not selected, the Layer list is displayed. You can select

• Any Layered Material Link defined under Materials in the current component.

• Any Layered Material Stack defined under Materials in the current component.

• Any Single Layer Material defined under Materials in the current component.

If you select an individual Layered Material Link, Layered Material Stack, or Single Layer 

Material, you can only select geometrical objects which are part of the selections of that 
feature. In most cases, you will then get access to a list of checkboxes where you can 
further limit the contributions to individually selected layers to which this contribution 
is to be added.
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I N T E R F A C E  F E A T U R E S

The interface features have a section named Interface Selection. The interface selection 
can be done by choosing from the following options:

• Top interface

• Bottom interface

• Exterior interfaces

• Interior interfaces

• All interfaces

• Selected interfaces

When Selected interfaces is chosen, the Interface list is displayed. You can select

• Any Layered Material Link defined under Materials in the current component.

• Any Layered Material Stack defined under Materials in the current component.

• Any Single Layer Material defined under Materials in the current component.

If you select an individual Layered Material Link, Layered Material Stack, or Single Layer 

Material, then you can only select geometrical objects which are part of the selections 
of that feature. In most cases, you will then get access to a list of checkboxes where you 
can further limit the contributions to individually selected interfaces to which this 
contribution is to be added.

L A Y E R  S E L E C T I O N S

When a physics feature acts on layers, the interpretations of layer selections are:

• A boundary selection in the geometry corresponds to a domain contribution in the 
selected layers.

• An edge selection in the geometry corresponds to boundary contributions on the 
faces of the layers exposed to that edge.

• A point selection in the geometry corresponds to edge contributions on corners of 
the selected layers meeting at the selected point.

This is illustrated in Figure 2-21 to Figure 2-23 where the patch at the lower left is the 
actual shell, and the 3D sketch shows an expanded view of what it would represent in 
the physical world.
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Figure 2-21: Boundary selection with layers 2 and 5 selected.

Figure 2-22: Edge selection with layers 2 and 5 selected.
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Figure 2-23: Point selection with layers 2 and 5 selected.

I N T E R F A C E  S E L E C T I O N S

When a physics feature acts on interfaces, the interpretations of interface selections are:

• A boundary selection in the geometry corresponds to boundary contributions on 
the selected interfaces.

• An edge selection in the geometry corresponds to edge contributions on the 
interface edges parallel to the selected edge.

• A point selection in the geometry corresponds to point contributions on the 
interface corners located at the selected point.

This is illustrated in Figure 2-24 to Figure 2-26 where the patch at the lower left is the 
actual shell, and the 3D sketch shows an expanded view of what it would represent in 
the physical world.
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Figure 2-24: Boundary selection with interfaces ‘layer 2 - layer 3’ and ‘layer 5 up’ selected.

Figure 2-25: Edge selection with interfaces ‘layer 2 - layer 3’ and ‘layer 5 up’ selected.
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Figure 2-26: Point selection with interfaces ‘layer 2 - layer 3’ and ‘layer 5 up’ selected.
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F a i l u r e  Mode l i n g

In composite laminates, it is quite common to have different kinds of failure modes. 
Thus it becomes essential to perform various kinds of failure analyses for composite 
laminates.

In this section:

• Failure Analysis

• Buckling Analysis

• Delamination Modeling

Failure Analysis

In COMSOL Multiphysics, both laminate theories allow computation of failure 
indices or safety factors based on the following criteria:

• von Mises Isotropic

• Tresca Isotropic

• Rankine Isotropic

• Saint-Venant Isotropic

• Jenkins Orthotropic

• Waddoups Orthotropic

• Tsai–Hill Orthotropic

• Hoffman Orthotropic

• Tsai–Wu Orthotropic

• Zinoviev Orthotropic

• Hashin–Rotem Orthotropic

• Hashin Orthotropic

• Puck Orthotropic

• LaRC03 Orthotropic

• Tsai–Wu Anisotropic

In addition to that, the ESL theory includes the following failure criteria:

• Azzi–Tsai–Hill Orthotropic
 2 :  C O M P O S I T E  M A T E R I A L S  M O D E L I N G



• Norris Orthotropic

• Modified Tsai–Hill Orthotropic

Add a Safety subnode to compute the safety factor for a given criterion. Additional 
built-in variables are available when multiple Safety subnodes are added. The combined 
safety factor, combined failure index, combined damage index, and combined margin 
of safety provide a conservative approach to safety assessment.

Buckling Analysis

Buckling of a composite laminate is a common phenomenon and also an important 
design consideration. It is crucial to design a composite laminate which can withstand 
compression or torsional buckling loads.

In COMSOL Multiphysics, both laminate theories can be used to compute the critical 
buckling load factor of a composite laminate.

Delamination Modeling

A composite laminate consists of many layers, glued or laminated together. Under 
different loading conditions, particularly impact loading, the bond between the two 
layers can break in a specific region.

Delamination initiation and propagation, and being able to predict how delaminated 
regions affect the response of a composite laminate, are important design 
considerations. In COMSOL Multiphysics, this can be modeled using the Delamination 
node in the Layered Shell interface. There are several different displacement and 
energy based cohesive zone models available, as well as different traction-separation 
laws. It is also possible to model contact between delaminated layers.

In the Structural Mechanics Module User’s Guide:

• The Safety node

• Safety Factor Evaluation

In the Structural Mechanics Module User’s Guide: Linearized Buckling 
Analysis
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In the Structural Mechanics Module User’s Guide: Delamination
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S t r u c t u r a l  C oup l i n g s

Composite laminates, modeled using layered shell elements, are often connected with 
solid or standard shell elements in different configurations to model real-world 
structures. The following structural couplings can be used to connect layered shell 
elements to solid or shell elements:

• Layered Shell — Shell Connection

• Layered Shell — Structure Cladding

• Layered Shell — Structure Transition

Layered Shell — Shell Connection

This coupling is used to create models where a combination of the Layered Shell 
interface and the Shell interface are used for different layers in the same layup, thus 
both interfaces are active on the same boundary. This type of modeling (multiple 
model method) is efficient when some layers are thin, while other layers are 
significantly thicker.

Layered Shell — Structure Cladding

This coupling is used to connect the top or bottom surface of layered shells to other 
shells, solids, or membranes. The coupling allows shared as well as parallel sets of 
boundaries.

Layered Shell — Structure Transition

This coupling is used to connect edges of layered shells to other shells or to boundaries 
of solids. The coupling allows you to choose only some of the layers of the layered 
shells.
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Mu l t i p h y s i c s  Mode l i n g

A composite laminate is most commonly designed based on structural requirements, 
but there are situations where other physical phenomena must be considered. There 
are two fundamentally different types of interactions between the mechanics of a 
laminate and other processes:

• Some physical processes occur inside the laminate. Examples are heat flux, electric 
currents, and diffusion processes.

• A laminate may act as a boundary of a 3D domain in which, for example, fluid flow 
is present.

Coupling to Electrical and Thermal Modeling

In some applications where electrical or thermal effects are significant, it can be 
important to design the laminate based on a combined response. The layered material 
technology in COMSOL Multiphysics allows you to use different physics interfaces in 
the same layered material, and it is possible to solve for all the physical phenomena 
simultaneously, using couplings between them.

From a structural design point of view, either laminate theory can be used together 
with electrical and thermal modeling of composite laminates. An example is Joule 
heating and thermal expansion of a composite laminate.

• The two multiphysics interfaces Thermal Stress, Layered Shell and Thermal Stress, 
Shell can be used to couple layered shell and shell elements to physics interfaces for 
heat transfer analysis.

• The Piezoelectricity, Layered Shell multiphysics interface can be used to couple the 
Layered Shell interface and the Electric Currents in Layered Shells interface to 
model piezoelectric layers in a composite laminate.

• The Piezoresistivity, Layered Shell multiphysics interface can be used to couple the 
Layered Shell interface and the Electric Currents in Layered Shells interface to 
model piezoresistive layers in a composite laminate.

Coupling to Fluid and Acoustics Modeling

You can model the interactions of composite laminates with a surrounding fluid, for 
fluid-structure interaction or acoustic applications. Models based on the ESL theory 
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are simplified and computationally fast. In comparison, models based on the layerwise 
theory more accurately capture the interaction of the composite laminate with its 
surrounding fluid domains, at an increased computational expense.

Coupling to Darcy’s Law for Poroelasticity Modeling

You can model the flow within porous composite laminates and its interaction with the 
structural shells. This interaction is supported by structural shell models based on the 
layerwise theory. The coupling occurs on the boundary level, where the pore pressure 
from the Layered Darcy’s Law interface acts as a load for the Layered Shell interface, 
causing swelling or shrinking. Changes in volumetric strain affect the pore space, 
acting as a mass source or sink in Darcy’s Law.

Coupling to Lumped Mechanical System Modeling

You can connect the finite element model obtained from Layered Shell interface to a 
lumped model obtained from Lumped Mechanical System interface using the 
Lumped–Structure Connection multiphysics coupling. The displacements obtained 
from the finite element model at the connection points are transferred to the lumped 
model. Similarly, the reaction forces obtained from the lumped model are applied to 
the finite element model. 
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Re s u l t s  E v a l u a t i o n

Composite laminates are defined on boundaries together with a layered material 
attached to them. As composite laminates are in general anisotropic, and in general 
heterogeneous in the through-thickness direction, evaluating results on the reference 
surface alone is usually not sufficient. You will need to evaluate results in each layer, as 
well as in the through-thickness direction.

In addition to the standard result presentation tools, COMSOL Multiphysics offers 
specialized methods for evaluating and plotting results in composite laminates:

• Layered Material Dataset

• Layered Material Slice Plot

• Through Thickness Plot

• Special Variables and Operators

Layered Material Dataset

Even though the composite laminate is modeled as a surface (2D) geometry, you can 
visualize the results on a geometry with finite thickness. For this, you use the Layered 

Material dataset.

The aspect ratio of a laminate is often high, so it is difficult to visualize variations in the 
thickness direction. For this reason, the Layered Material dataset provides an option to 
scale the geometry in the thickness direction.

Using this dataset, you can plot the results in two ways:

• Plots can be done on a full 3D geometry.

• You can create slices in the shell at different levels. The slices can be placed at mesh 
vertices in the thickness direction, at layer midplanes, or at interfaces.

Below is an example of a how a thin composite laminate with two layers can be 
visualized. The geometry is a cylinder which is viewed along its axis. In Figure 2-27, 
the following evaluation and plotting modes are shown:

• Case A: The geometry. This is what you see if you do not use the specialized dataset.

• Case B: Layered material dataset with true thickness (the default). It shows a solid 
representation, and you would need to zoom in to resolve details.
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• Case C: Layered material dataset with 20x scaling in the thickness direction.

• Case D: Layered material dataset with 20x scaling in the thickness direction, and 
slices at the mesh vertices.

• Case E: Layered material dataset with 20x scaling in the thickness direction, and 
slices at the layer midplanes.

• Case F: Layered material dataset with 20x scaling in the thickness direction, and 
separate slices at the interfaces.
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Figure 2-27: The modeled geometry and various ways to use a Layered Material dataset 
to evaluate results in a layered material.

Case A Case B

Case C Case D

Case E Case F

In the COMSOL Multiphysics Reference Manual: The Layered Material 
dataset
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Layered Material Slice Plot

As described in the previous section, you can generate slice plots using the layered 
material dataset. You can also use a Layered Material Slice plot which allows you to plot 
many layers or interface. You can optionally arrange them in a linear or rectangular 
array, and add layer numbers to the plot automatically. The plot is also useful in the 
following cases:

• When you want to create a slice only in one or a few selected layers.

• When you want to create a slice plot through some or all layers, but not necessarily 
perpendicularly to the thickness direction.

• When you want to examine a particular layer in detail, and want to plot the results 
at a position within the layer, away from the midplane.

Figure 2-28: Example of a Layered Material Slice plot, where the Second Piola-Kirchhoff 
stress is plotted in all the layers of a laminate with six layers ([30/-45/75/-75/45/30]).

In the COMSOL Multiphysics Reference Manual: The Layered Material 
Slice plot.
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Through Thickness Plot

Composite laminates are in general heterogeneous in the thickness direction. It is often 
desirable to plot the variation of a quantity in the through-thickness direction, at 
certain locations on the boundary.

To this end, you can use a Through Thickness plot in which any quantity can be plotted 
against laminate thickness. You can select one or more geometric points on the 
boundary, or optionally create cut point datasets. It is also possible to specify point 
coordinates directly.

The result quantity is plotted on the x-axis, and the thickness coordinate is plotted on 
the y-axis. An example of a through-thickness plot is shown in Figure 2-29.

Figure 2-29: Example of a Through Thickness plot, where the transverse shear stress is 
plotted at a particular point on a composite laminate with three layers ([0/90/0]).

In the COMSOL Multiphysics Reference Manual: The Through 
Thickness plot.
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Special Variables and Operators

There are special variables available in the extra dimension. These variables can be used 
in the physics and in postprocessing, and work in connection with a Layered Material 
dataset. See Layered Material Dataset.

• <phys>.xd: The extra dimension coordinate is wrapped into a physics interface 
variable, for example lshell.xd. The coordinate varies from 0 at the bottom to the 
laminate thickness d at the top.

• <phys>.xd_rel: The relative extra dimension coordinate that varies between 0 at 
the bottom to 1 at the top.

• <phys>.zl: The extra dimension coordinate that varies between −d/2 at the 
bottom to d/2 at the top.

• <phys>.num: The layer number that is 1 for the bottom layer and N for the top 
layer.

There are special operators available that can handle common operations in the extra 
dimension. These operators work with a Solution dataset.

• <phys>.atxd1(xdim_location,expr): Extra dimension evaluation of expr on 
1-dimensional entity at given extra dimension coordinate. The operator can be used 
to access any variable defined on a layer level product selection at a particular extra 
dimension location.

• <phys>.atxd0(xdim_location,expr): Extra dimension evaluation of the 
expression on 0-dimensional entity at given extra dimension coordinate. The 
operator can be used to access any variable defined on an interface-level product 
selection at a particular extra dimension location.

• <phys>.xdintopall(expr): Extra dimension integration of the expression on 
1-dimensional entity. The expression must be wrapped inside the mean or extra 
dimension mean operators if it is a variable defined on the higher dimension.

• <phys>.xdintopallint(expr): Extra dimension integration of the expression on 
0-dimensional entity. The expression must be wrapped inside the mean or extra 
dimension mean operators if it is a variable defined on the higher dimension.

• <phys>.xdsumbnd(expr): Extra dimension summation of the expression on a 
boundary. Useful to compute reaction forces and moments on the specific 
boundary.

• <phys>.xdsumedg(expr): Extra dimension summation of the expression in an 
edge. Useful to compute reaction forces and moments in the specific edge.
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• <phys>.xdsumpnt(expr): Extra dimension summation of the expression in a 
point. Useful to compute reaction forces and moments in the specific point.

• <phys>.xdavgbnd(expr): Extra dimension average of the expression on a 
boundary. 

• <phys>.xdavgedg(expr): Extra dimension average of the expression in an edge.

• <phys>.xdavgpnt(expr): Extra dimension average of the expression in a point.

See Solution, Layered Material, Layered Material Slice, and Through 
Thickness in the COMSOL Multiphysics Reference Manual for details 
about the Solution dataset, the Layered Material dataset, and slice and 
through-thickness plots in layered materials.

Using Extra Dimensions in the COMSOL Multiphysics Reference 
Manual.
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